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Symulacja i pomiar, czyli 
LTspice i Analog Discovery 2 
w rękach konstruktora (23)
O czym nie mówiliśmy, a powinniśmy

Niniejszy cykl trwa już bardzo długo. To wystarczający 
powód do tego, by przeanalizować poruszane zagad-
nienia. Okazało się, że jest kilka tematów, o których 
nie było mowy, a z racji tego, że należałoby je zaliczyć 
do podstawowych, powinny być choćby wspomniane. 
Nadrabiamy zaległości.

definiować własne elementy. Zalety schematów hierarchicznych 
pokazano na przykładzie. Naszym zadaniem jest symulacja układu 
elektronicznego selektywnie filtrującego kilka częstotliwości. Użyt-
kownik musi mieć oczywiście możliwość łatwego strojenia filtrów. 
Problem rozwiążemy, stosując mostki „podwójne T”.

Pierwszym, naturalnym podejściem jest narysowanie kilku takich 
mostków na jednym schemacie. Ponieważ mamy zapewnić łatwą moż-
liwość strojenia, warto zapewnić parametryczne zadawanie warto-
ści każdego elementu. Jeden mostek zawiera 6 elementów. Gdybyśmy 
chcieli zastosować np. 4 takie mostki, przestrojenie ich wszystkich 
wymagałoby zmiany wartości aż 24 elementów. Parametryzacja zre-
dukuję tę liczbę do 8. Przykład kompletnego schematu pokazanoo 
na rysunku 1a, a wykresy częstotliwościowe na rysunku 1b. Para-
metry elementów każdego filtru umieszczono tak, aby było wyraźnie 
widoczne, do którego z nich się odnoszą.

Rozpoczynamy od ważnego zagadnienia, które nie było omawiane 
wprost, a jest jedną z ważniejszych cech symulatora LTspice.

Hierarchiczna struktura schematów
Hierarchiczna struktura schematów symulatora LTspice jest jedną 
z najważniejszych cech tego programu. Zwiększa ich czytelność, 
szczególnie wtedy, gdy są  znacznie rozbudowane, pozwala też 
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Teraz tę samą symulację przeprowadzimy 
z zastosowaniem schematu hierarchicznego. 
Najpierw należy zbudować podstawową struk-
turę filtru. Rysujemy więc schemat tak, jak 
to robimy w przypadku każdego symulowa-
nego układu. Nie wprowadzamy jednak kon-
kretnych wartości elementów, a definiujemy je 
parametrycznie (rysunek 2). Ważne jest nadanie 
etykiet wszystkim węzłom, do których będzie 
konieczny dostęp ze schematu o wyższym po-
ziomie hierarchicznym. W tym przypadku jest 
to węzeł wejściowy („we”) i wyjściowy („wy”). 
Schemat zapisujemy w formacie ASC, a więc 
takim, jak każdy symulowany układ. Warto po-
nadto nadać nazwę jednoznacznie kojarzącą się 
z funkcją układu. Niech to będzie filtrTT.asc.

Aby korzystać z tak zaprojektowanego filtru, 
konieczne jest zdefiniowanie jego oznaczenia schematowego, Otwie-
ramy więc odpowiednie okno edytora: File → New Symbol (rysunek 3). 
Na ekranie ukazuje się pusta plansza z symbolem kotwicy tworzonego 
elementu. Rysujemy wokół niej prostokąt (Draw → Rect lub przycisk R 
na klawiaturze) o rozmiarach 4×2 oczka siatki. Kolejną czynnością jest 
naniesienie wyprowadzeń filtru (Edit → Add Pin Port lub przycisk P), 
do których doprowadzamy połączenia z prostokątem symbolizującym 
filtr. Każdy taki element musi mieć swoje oznaczenie (etykietę) i numer 
porządkowy, które wprowadzamy bezpośrednio po wybraniu powyższej 
komendy. Dodatkowo możemy decydować o tym, czy etykieta ma być 
wyświetlona na schemacie, czy nie. Jeśli decydujemy się na wyświet- 
lanie, możemy dodatkowo określić jej położenie względem pinu – opcje 
TOP, LEFT, RIGH, DOWN, Vertical Text i Offset (rysunek 4). Aby uczy-
nić symbol filtru bardziej czytelnym, w obrębie prostokąta umieściliśmy 
ponadto grafikę przypominającą charakterystykę filtru TT. Jest ona wy-
konana przy użyciu polecenia Draw-Line.

Umieszczanie etykiet z jednej strony ułatwia później, w trakcie tworze-
nia schematu symulowanego układu, rozpoznawanie funkcji poszczegól-
nych wyprowadzeń, jednak nie mamy możliwości ustawiania wielkości 
liter i dla niewielkich elementów będą one zaciemniały schemat. W takich 
przypadkach korzystniejsze jest wyłączenie wyświetlania etykiet – opcja 
NONE (Not Visible) i zamiast nich wstawienie tekstu komentarza (Draw 
→ Text). Teraz już można wybrać wielkość liter, np.: Font size=0,625. Tak 
zdefiniowany symbol będzie bardziej czytelny na schemacie.

Pozostaje jeszcze uzyskanie dostępu do parametrów filtru, które po-
winny być jakoś przekazywane do najwyższego poziomu hierarchii przez 
symbol schematowy. W tym celu definiujemy domyślne parametry R i C, 
Przyjmujemy np., że R będzie równe 1 kΩ, a C 10 nF. Przy każdym wpro-
wadzeniu filtru na schemat jego parametry będą określone tak przyjętymi 
wartościami. Możemy je oczywiście zmienić już na schemacie układu 
symulowanego w dowolnym momencie. Będzie to potrzebne do stroje-
nia filtru w trakcie symulacji. Parametry nanosimy poprzez atrybut Spa-
ceLine. Wykonujemy polecenie Edit-Attributes, wybieramy opcję Edit 
Attributes i wypełniamy odpowiednie pole (rysunek 5). Warto ponadto 
uczynić ten atrybut widocznym na schemacie, co następuje po wskaza-
niu go w oknie atrybutów (Ctrl W) i umieszczeniu w stosownym miejscu 
na schemacie. Wynik powyższych prac zapisujemy w pliku o takiej sa-
mej nazwie jak schemat, tylko z automatycznie zmienionym rozszerze-
niem na ASY (filtrTT.asy). Element warto zapisać w domyślnym folderze 
zawierającym biblioteki elementów. Będzie wówczas zawsze widoczny 
w programie. Jeśli o to nie zadbamy, może być później problem z dostę-
pem do niego. Aby stał się widoczny, tworzony schemat układu symu-
lowanego powinien być zapisany w folderze, w którym znajduje się plik 
filtTT.asy lub w którymś z nadrzędnych. 

Na tym kończą się prace nad definiowaniem własnego elementu na-
leżącego do najniższego poziomu struktury schematu. Możemy przy-
stąpić do symulacji z jego zastosowaniem. Teraz nie musimy rysować 
każdego filtru, korzystamy z przygotowanego elementu schematowego. 

Rysunek 1. Symulacja układu z czterema filtrami selektywnymi: a) schemat, b) charaktery-
styki częstotliwościowe

Rysunek 2. Schemat filtru „TT” z parametrycznie określonymi warto-
ściami elementów

Rysunek 4. Okno właściwości wprowadzanego pinu

Rysunek 3. Menu z poleceniami 
otwierającymi arkusz edycji 
nowego symbolu

Rysunek 5. Okno wprowadzania domyślnych wartości elementów 
filtru

Otwieramy czysty arkusz i umiesz-
czamy na nim symbol filtru (Edit 
→ Component lub przycisk F2). 
Jeśli elementu nie ma w  zesta-
wieniu, wybieramy na widocznej 
u góry okna liście Top Direktory 
katalog, w którym został zapisany 
nasz filtr. Powinien się po tym po-
kazać element filtrTT (rysunek 6). 
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Wybieramy go i od razu powie-
lamy w czterech egzemplarzach. 
Następnie stroimy filtry. Można 
to wykonać na kilka sposobów. 
Po  pierwsze, klikamy na  war-
tości elementów wyświetlane 
pod prostokątem symbolizują-
cym filtr (rysunek 7). Otwiera 
się po tym okno edycji parame-
trów, w którym wpisujemy żą-
dane wartości. Druga metoda 
polega na  kliknięciu prawym 
przyciskiem myszki w obrębie 
elementu symbolizującego filtr. 
Oprócz możliwości zmiany parametrów filtru można również przepro-
wadzić edycję jego symbolu schematowego (przycisk ekranowy Open 
Symbol) oraz schematu filtru (Open Schematic) – rysunek 8. 

Filtry stroimy dokładnie tak samo jak 
w pierwszej symulacji, tzn.: R1=1 kΩ, C1=1 nF 
(1. filtr), R2=1 kΩ, C2=10 nF (2. filtr), R3=1 kΩ, 
C2=100 nF (3. filtr) i R4=10 kΩ, C2=100 nF 
(4. filtr). Warto zauważyć, że nadal pozostaje 
możliwość parametrycznego określania war-
tości elementów tak, jak to zaprezentowano 
w ostatnim 5. filtrze. Pełny schemat układu fil-
trującego i wyniki symulacji zostały pokazane 
na rysunku 9.

Funkcje
Funkcje były już wprawdzie opisywane w 13. od-
cinku, w którym omawialiśmy symulację me-
todą Monte Carlo. Wracamy do nich, ale w nieco 
innym kontekście, Tym razem, oprócz typowej 
funkcji definiowanej przez użytkownika, czyli przez nas, zastosujemy 
jedną z wielu funkcji bibliotecznych symulatora LTspice. Ale po kolei...

Ostatnio zadano mi pytanie: „No dobrze, ale właściwie po co nam sy-
mulator?” Poniższy przykład może być odpowiedzią. Wyobraźmy sobie, 
że budujemy system nawigacji bezwładnościowej oparty na akcelero-
metrze. Nie jesteśmy pewni ani rozwiązań układowych, ani parame-
trów technicznych, które należy przyjąć do realizacji projektu. Zamiast 
budować w ciemno urządzenie i pracować na jego fizycznym modelu, 
co oczywiście wiąże się z kosztami, może lepiej sprawdzać jego działanie 
na modelu wirtualnym. Zastosujemy to podejście do projektowanej na-
wigacji. Nie będziemy tu budować kompletnego urządzenia, sprawdzimy 
jedynie koncepcję na uproszczonym jednowymiarowym rozwiązaniu. 
Mamy zatem jednoosiowy akcelerometr ustawiony w kierunku ruchu. 
Jeżeli nie dysonujemy żadnym fizycznym akcelerometrem, możemy wy-
generować jakieś teoretyczne dane wejściowe. Ja akurat miałem takie 
urządzenie, więc użyłem go do zebrania rzeczywistych danych wejścio-
wych. Problem wózka rozwiązałem, korzystając z samochodzika zabawki. 
Akcelerometr zainstalowałem w jego kabinie. Wózek rozpędzamy i pusz-
czamy, pozwalając na wyhamowanie na skutek sił tarcia. Przyspiesze-
nie jest w trakcie eksperymentu rejestrowane, a następnie zapisywane 
w formacie tekstowym w postaci par liczb: (czas, przyspieszenie). Dane 
takie można bez trudu zaimportować w symulatorze do źródła napię-
ciowego z funkcją PWL. Zapewniamy w ten sposób połączenie świata 
rzeczywistego z wirtualnym.

Na schemacie z rysunku 10 jest to źródło V1, a pochodzący z tego wir-
tualnego akcelerometru sygnał jest dostępny w węźle opisanym etykietą 
AX. Po wykonaniu wstępnej symulacji czasowej okazuje się, że sygnał 
ten jest dość mocno zaszumiony (rysunek 11). Widać w nim każdą nie-
równość podłoża, po którym porusza się wózek. Istnieje więc podejrze-
nie, że konieczna będzie jakaś filtracja tego sygnału. Ale jak dobrać rząd 
filtru i jego częstotliwość graniczną? Czy w ogóle ten zabieg faktycznie 
będzie potrzebny?

Rysunek 7. Okno wprowadzania parametrów elementu z niższego 
poziomu hierarchicznego – metoda 1

Rysunek 8. Okno wprowadzania parametrów elementu z niższego 
poziomu hierarchicznego – metoda 2

Rysunek 10. Schemat do sprawdzenia koncepcji układu nawigacji 
bezwładnościowej

Rysunek 6. Okno wyboru elemen-
tu bibliotecznego użytkownika

Rysunek 9. Wyniki symulacji układu filtrującego z zastosowaniem schematu hierarchicznego

Rysunek 11. Wykres rzeczywistego przy-
spieszenia zarejestrowanego podczas 
poruszania się wózka

Do  rozstrzygnięcia 
tej wątpliwości zastosu-
jemy model filtru dol-
noprzepustowego. Nie 
będziemy go  jednak 
budować na  piechotę 
z  elementów elektro-
nicznych –  wzmac-
niaczy operacyjnych, 
kondensatorów, re-
zystorów itp. Skorzy-
stamy z  cyfrowego 
modelu opisanego tylko 
transmitancją. W  sy-
mulacji posłużymy 
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jest kopiowanie wykresów z poszczególnych węzłów obwodu do kilku, 
a nawet wszystkich paneli. Panel dodaje się, np. klikając prawym przy-
ciskiem myszki w oknie wykresu, a następnie wybierając polecenie Add 
Plot Pane. Autorzy programu przyjęli, że nowy panel pojawia się u góry 
okna. Mnie osobiście bardzo to przeszkadza. Zwykle operacja ta jest wy-
konywana po to, by wprowadzić jakiś dodatkowy wykres, który nie jest 
najważniejszy w całej kolekcji, a jako ten mniej ważny powinien zna-
leźć się – moim zdaniem – na dalszej pozycji. To oczywiście bardzo su-
biektywna ocena. Szkoda, że nie ma możliwości ustalania jakiejś opcji 
w parametrach symulatora, która dawałaby pewien manewr w tym za-
kresie. Tymczasem chyba nie ma możliwości zmiany kolejności paneli, 
pozostaje więc ręczne przerzucenie wykresów. Czynność jest prosta, 
ale na skutek różnych reakcji symulatora na naciskanie poszczególnych 
przycisków, czy to klawiatury komputera lub myszki, należy zachować 
odpowiednią kolejność ich naciskania.

Aby przenieść dany wykres z jednego panelu do innego, należy naje-
chać kursorem myszki na nazwę wykresu widoczną nad nim, nacisnąć 
lewy przycisk myszki i trzymając go, przenieść kursor do żądanego pa-
nela. W chwili zwolnienia przycisku wykres zostanie przeniesiony. Cza-
sami chcemy pozostawić oryginał w pierwotnym panelu, a dany wykres 
tylko skopiować do innego. W tym przypadku, po naciśnięciu lewego 
przycisku myszki, dodatkowo naciskamy przycisk Ctrl na klawiaturze. 
Powoduje to dodanie znaku plus ma kursorze myszki, co wyraźnie sy-
gnalizuje zamiar wykonania kopii wykresu. 

Co zrobić, jeśli chcemy usunąć jakiś wykres, a nawet cały panel? 
Do kasowania wszelkich elementów przewidziano użycie przycisku F5. 
Jego naciśnięcie powoduje zmianę wyglądu kursora myszki, który przy-
biera teraz postać nożyczek. Naprowadzenie kursora na nazwę wykresu 
(w górnej części panelu) i kliknięcie lewym przyciskiem myszki powo-
duje usunięcie wykresu. Cały panel wraz z jego zawartością usuwamy, 
klikając prawym przyciskiem myszki w obszarze wykresu, a następnie 
wybierając komendę Delete this Pane. Na szczęście operacja jest odwra-
calna dzięki komendzie Undo (ikonka zawiniętej strzałki w lewo na pa-
sku narzędziowym).

Czasami konieczne jest powiększenie jakiegoś fragmentu wykresu. 
Intuicyjnie korzystamy z ikonki lupy ze znakiem +. Możemy wówczas 
otoczyć interesujący nas fragment wykresu, korzystając z lewego przyci-
sku myszki. Bardzo często, szczególnie wtedy, gdy wycinamy jakiś wąski 
przedział czasowy, oś pionowa ulega przeskalowaniu. W rezultacie wy-
kres wygląda tak, jakby uległ spłaszczeniu, a więc skala pionowanie nie 
jest wykorzystywana w pełni. Do optymalnego rozciągnięcia wykresu 
w pionie służy ikonka z wizerunkiem wykresu z dwiema strzałkami 
pionowymi (rysunek 14). Przydatną, chociaż nieco dziwnie działającą 
czynnością jest przesuwanie wykresu w dowolnym kierunku wewnątrz 
panelu. W tym celu należy naprowadzić kursor myszki na wykres, na-
cisnąć przycisk Ctrl i poruszając myszką, ustawić wykres w żądanym 
położeniu. Po zwolnieniu przycisku wykres jest jednak odświeżany z mi-
nimalną zmianą położenia. Jest to efekt niepożądany i nieco irytujący. 

Symulując układy z dużą liczbą elementów i połączeń, często chcemy 
sprawdzić wzajemne zależności między poszczególnymi sygnałami. 
Tworzymy więc wykresy z kilkoma panelami, a w każdym umiesz-
czamy po kilka przebiegów. Coraz trudniej przychodzi nam oriento-
wanie się, który wykres należy do którego węzła obwodu. Można sobie 
radzić, nadając etykiety poszczególnym sygnałom. Bywa, że schemat 
jest tak gęsty, że nie ma już miejsca na etykietę, albo traci on na czy-
telności z powodu nadmiaru symboli. W takich przypadkach dobrym 
trikiem jest naprowadzenie kursora myszy na nazwę interesującego nas 
wykresu (widoczną nad panelem), naciśnięcie lewego Alt i kliknięcie 
lewym przyciskiem myszki. Wskazany węzeł lub element zostaje pod-
świetlony (standardowo na żółto) – rysunek 15.

I jeszcze jeden trik związany z wykresami i opcjonalnymi pomiarami, 
które można za ich pomocą wykonać. I tym razem korzystamy z lewego 
przycisku Alt, po naciśnięciu którego wskazujemy jakiś element na sche-
macie i klikamy lewym przyciskiem myszki. Pojawia się wówczas do-
datkowy wykres mocy wydzielanej na tym elemencie. Jest to wykres 

Rysunek 12. Wyniki symulacji koncepcyjne-
go układu nawigacji bezwładnościowej bez 
filtrowania sygnału

Rysunek 13. Wyniki symulacji koncepcyjnego 
układu nawigacji bezwładnościowej z za-
stosowaniem filtru 2. rzędu o częstotliwości 
granicznej 20 Hz

się behawioralnym 
źródłem napięcio-
wym B2, którego 
napięcie jest opisane 
przekształceniem 
Laplace’a: V=v(ax) 
Laplace=(1/((1+s/
(2·π·f0))̂ n)). Zbu-
dowaliśmy w  ten 
sposób filtr dolno-
przepustowy filtru-
jący sygnał z węzła 
AX. Ma on parame-
trycznie zadawaną 
częstotliwość gra-
niczną f0, regulo-
wany jest też rząd 
filtru n.

Przed nami naj-
ważniejsze zadanie: 
musimy obliczyć tra-
jektorię wózka. Z fi-
zyki wiemy, że całka 
z  przyspieszenia 
to prędkość, a całka 
z prędkości to droga. 
Powinniśmy więc 
dwukrotnie scałko-
wać sygnał z  akce-
lerometru. Znowu 
korzystamy ze  źró-
dła behawioralnego. 
Tym razem napięcie 
źródła jest obliczane 
za pomocą funkcji 
bibliotecznej idt liczącej całkę. Ma ona co najmniej jeden parametr, 
którym jest funkcja podcałkowa. W naszym przypadku do obliczenia 
prędkości poprzez całkowanie przyspieszenia AX użyjemy źródła B1, 
a do obliczenia drogi skorzystamy z analogicznego źródła B3 całkują-
cego tym razem prędkość (węzeł „v1”). Sygnał ze źródła B3 opisany ety-
kietą „s1” jest odległością, którą pokonał wózek. Wynik symulacji został 
pokazany na rysunku 12.

Dystans, jaki pokonał wózek, można wyznaczyć, mierząc koń-
cową wartość na wykresie v(s1). Ustawiamy więc kursor na końcu 
tego wykresu i odczytujemy wynik: 2,63. Jednostka „wolty” wynika 
oczywiście z zastosowania w symulacji źródła napięciowego. Wyniki 
z akcelerometru są podawane w m/s2, mamy więc proste przełożenie 
metrów na wolty. Ostatecznie możemy więc stwierdzić, że wózek prze-
jechał 2,63 metra. Pozostaje jeszcze weryfikacja wyniku z rzeczywi-
stym pomiarem odległości i... okazuje się, że zmierzony taśmą dystans 
to 2,65 m. To wręcz niewiarygodna zgodność... Ciesząc się z takiego 
wyniku, nie mogę jednak odnieść wrażenia, że to chyba jednak zbieg 
jakichś wyjątkowo korzystnych okoliczności. 

W tej sytuacji wracamy do pytania zadanego na wstępie: czy konieczna 
jest filtracja sygnału akcelerometru? Trudno przypuszczać, abyśmy uzy-
skali tą metodą lepszy wynik. Dla formalności jednak zastosujemy filtr. 
Ustalamy częstotliwość graniczną 20 Hz i rząd filtru równy 2. Wyniki 
przedstawiono na rysunku 13. Wniosek jest dość zaskakujący. Okazuje 
się, że można zrezygnować z filtrowania sygnału.

Wykresy
Obsługę wykresów powinniśmy już w zasadzie dobrze znać. Jest jed-
nak kilka zagadnień, które warto zebrać w jednym miejscu. Wiemy już, 
że w jednym oknie wykresu można umieszczać kilka paneli, a każdy 
z nich może zawierać pogrupowane tematycznie wykresy. Dopuszczalne 
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czasowy, a więc widzimy wartości chwilowe tej mocy. Po naciśnięciu 
Ctrl i kliknięciu na nazwę wykresu pojawia się okno, w którym jest wy-
świetlana moc średnia oraz energia wydzielona w elemencie w przedziale 
czasowym obejmowanym przez wykres. 

Na zakończenie rozważań na temat wykresów warto wspomnieć o moż-
liwości niezależnego skalowania osi czasu w poszczególnych panelach. 
Zwykle chcemy, aby wszystkie wykresy były wyświetlane współbieżnie. 
Pozwala to obserwować wzajemne powiązania między poszczególnymi 
sygnałami. Są jednak wyjątkowe sytuacje, których niezależne skalowanie 
może być przydatne. Przykładem niech będzie multiwibrator przedsta-
wiony na schemacie z rysunku 16. Generuje on przebieg prostokątny do-
stępny na kolektorach obu tranzystorów. Można go obejrzeć w dłuższym 
czasie, co pozwoli np. przeprowadzić analizę widmową. Jednak w ukła-
dzie można dostrzec stan nieustalony w chwili jego włączania, któremu 
warto przyjrzeć się z bliska, nie tracąc przy tym wglądu w całość. Znane 
już nam zoomowanie wykresu za pomocą lupy 
obejmuje wszystkie wykresy, we wszystkich 
panelach. Korzystając z tego narzędzia, utra-
cilibyśmy zatem możliwość podglądu całego 
przebiegu. Aby na jednym wykresie wyświet-
lić wybrany przebieg w powiększeniu, musimy 
kliknąć prawym przyciskiem myszki na wykre-
sie i wyłączyć opcję Sync.Horiz.Axes. Następnie 
otwieramy nowy panel i umieszczamy w nim 
kopię przebiegu wybranego do powiększenia. 
Teraz klikając na nim prawym przyciskiem 
myszki, wybieramy komendę: View → Manual 
Limits, i w polach Horizontal Axis wprowa-
dzamy odpowiednie parametry czasowe, które 
zdefiniują nam okno powiększenia. Niestety, 
od tego momentu nie jest możliwe stosowanie 
narzędzia „lupa”.

Nieudokumentowane polecenia 
LTspice
Takie nieudokumentowane polecenia to praw-
dziwy kąsek dla użytkowników. Znając je i umie-
jętnie wykorzystując, stawiamy się – to nic, że we 
własnym mniemaniu – na pozycji wybitnych 
fachowców od tematu. Potrafimy przecież robić 
to, o czym inni użytkownicy nie mają pojęcia. 

Kilka takich sztuczek było już użytych w ni-
niejszym cyklu, choć nie było to  specjalnie 
nagłaśniane. Okazuje się, że takich nieudoku-
mentowanych poleceń jest dość dużo. Ciekawe, 
dlaczego autorzy programu nie zawarli ich w opi-
sie programu? Może nie dają gwarancji na po-
prawne ich działanie? Kto wie, może pod jakąś 
kombinacją klawiszy ukryty jest jakiś symulator 
lotu, jak to było w jednej z pierwszy wersji Ex-
cela. Takie polecenia są mniej lub bardziej potrzebne, ale warto je znać. 
Wymienimy więc tylko niektóre.

1. �Etykieta z negacją. To polecenie jest szczególnie przydatne podczas 
symulacji układów cyfrowych. Bardzo często występują w nich sy-
gnały proste i zanegowane. Sygnały zanegowane są oznaczane zwy-
kle nadkreślonym napisem tak, jak to pokazano na rysunku 17. Efekt 
taki jest uzyskiwany przez dodanie znaku podkreślenia przed tek-
stem etykiety.

2. �Wyświetlanie ukrytych parametrów elementów. Elementy takie, jak 
kondensatory czy cewki mają szereg dodatkowych parametrów, które 
nie są standardowo wyświetlane na schemacie, aby nie zmniejszać 
jego czytelności. Na przykład dla kondensatora są to: pojemność 
(to oczywiste), napięcie znamionowe, prąd znamionowy, ekwiwa-
lentna rezystancja szeregowa (ESR), ekwiwalentna indukcyjność 
szeregowa, ekwiwalentna rezystancja równoległa i ekwiwalentna 

Rysunek 14. Ikonka 
rozciągania wykre-
su w pionie

Rysunek 15. Ilustracja metody podświetlania węzła na schemacie, do którego odnosi się 
wskazany przebieg na wykresach

Rysunek 16. Przykład stosowania niezależnego skalowania osi czasu w różnych panelach 
na wykresie

Rysunek 17. Ilustracja metody 
wprowadzania etykiet ze znakiem 
negacji

ją przytoczyć jeszcze raz tu-
taj. Jak wiemy, użytkownik 
może wygenerować niemal 
dowolny własny przebieg, 
korzystając np.  ze  źró-
dła napięciowego z  opcją 
PWL. Dane numeryczne 
przebiegu są  zapisywane 
w wierszach zawierających 
parametry czas, napię-
cie. Dane te, jeśli jest ich 
niewiele i można je wprowa-
dzić ręcznie, najwygodniej 
jest zapisać w wewnętrznej 
tablicy symulatora. Gdy robi 

pojemność równoległa. Parametry te można 
sprawdzić, wyświetlając właściwości ele-
mentu (kliknięcie prawym przyciskiem 
myszki na  elemencie). Wyświetlana jest 
wówczas tabelka z parametrami. Podobne 
informacje można uzyskać, naprowadzając 
kursor myszki na dany kondensator i na-
ciskając jednocześnie przyciski Shift-Ctrl-
-Alt-H. Wszystkie zdefiniowane dla tego 
elementu ukryte parametry są wyświetlone na schemacie standar-
dowo żółtą czcionką w pobliżu oznaczenia schematowego (rysu-
nek 18). Domyślny, żółty kolor nie jest najlepszym rozwiązaniem, 
tym bardziej że zastosowano najmniejszą czcionkę.

3. �Generowanie przebiegów definiowanych numerycznie w pętli skoń-
czonej lub nieskończonej. Z tej cechy już korzystaliśmy, ale warto 
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Symulacja i pomiar, czyli LTspice i Analog Discovery 2 w rękach konstruktora. O czym nie mówiliśmy, a powinniśmy

się ich zbyt dużo, można je zachowywać w plikach dyskowych 
w formacie tekstowym.

W poniższym przykładzie zapisano w ten sposób krótkie sygnały 
sinusoidalne, które wykorzystamy do generowania tekstu zapisanego 
alfabetem Morse’a. Kropka trwa 150 ms, kreska 450 ms, odstęp mię-
dzy elementami znaku trwa 150 ms, a odstęp między znakami trwa 
450 ms. Do generowania telegramu zastosujemy źródło napięciowe 
V1 z opcją PWL. Argumentami będą pliki z zapisanymi kropkami 
i kreskami połączone za pomocą nieudokumentowanej opcji REPEAT 
ENDREPEAT. Naszym zadaniem jest nadanie komunikatu „AVT” za 
pomocą dźwiękowych znaków Morse’a. Dla sprawdzenia efektu koń-
cowego zastosujemy komendę .wave avt.wav 16 44.1k v(wy) 
zapisującą efekt pracy naszego automatycznego klucza telegraficz-
nego w pliku dźwiękowym avt.wav. Defi-
nicja sygnału generowanego przez źródło 
V1 jest następująca:
PWL repeat for 1(file=kropka.
txt)endrepeat repeat 
for 1(file=kreska.txt)
endrepeat +450m 0 repeat for 
3(file=kropka.txt)endrepeat 
repeat for 1(file=kreska.txt)
endrepeat +450m 0 repeat for 
1(file=kreska.txt)endrepeat

Jak widać, w  powyższym zapisie łą-
czone są różne techniki określania para-
metrów. Opcje REPEAT mogą być ponadto 
zagnieżdżane. Na rysunku 19 pokazano 
wygenerowany przebieg w całości i jeden 
powiększony jego fragment. Komunikat 
można odsłuchać z pliku avt.wav.

4. �Renumeracja elementów. Niezwykle przy-
datna funkcja dla użytkowników lubiących 
porządek na schemacie. W trakcie projekto-
wania często usuwamy ze schematu różne 
elementy, a zamiast nich wstawiamy inne. 
LTspice automatycznie numeruje każdy 
wstawiany do schematu element, nadając 
mu kolejny numer. Przy wielokrotnie po-
wtarzanej operacji zamiany elementów two-
rzą się więc dziury w numeracji. Naciskając 
kombinację przycisków Shift-Ctrl-Alt-R, 
wymuszamy renumerację elementów 
od zera. Prosty zabieg, a jakże przydatny.

5. �Symulacja wymiany typów elementów. Za-
łóżmy, że projektujemy wzmacniacz tran-
zystorowy. Punkty pracy wyznaczone, 
napięcia się zgadzają, ale parametry częstotliwościowe zwykle nie 
są łatwe do obliczenia. Wymagają wielu obliczeń, a i tak trudno 
uwzględnić wszystkie elementy, które mogą wpływać na charakte-
rystykę częstotliwościową. Jedna mała pojemność złącza kolektor-
-baza zastosowanego tranzystora może spowodować, że cały projekt 
nadaje się do kosza. Ratunkiem jest symulacja metodą prób i błędów. 
Po prostu bierzemy kolejne typy tranzystorów i patrzymy, który 
z nich nadaje się do projektu, a który nie. Wspaniale byłoby móc 
porównywać np. charakterystyki układu z poszczególnymi typami 
tranzystorów, ale trzeba by tworzyć kilka niemal identycznych sche-
matów różniących się jedynie typami tranzystorów. Jest prostsza me-
toda polegająca na zastosowaniu polecenia .step param, którego 
argumentem byłby typ tranzystora. Problem jednak polega na tym, 
że polecenie param nie dopuszcza użycia nienumerycznych argu-
mentów. Na szczęście w symulacjach dozwolone jest używanie alia-
sów. Będziemy więc w nich ukrywać alfanumeryczne oznaczenia 
elementów. Alias poprzedzamy tekstem „ako:”, po którym następuje 
biblioteczny typ tranzystora. W przykładzie użyjemy tranzystorów: 

Rysunek 18. Wyświetlanie ukry-
tych parametrów elementów

Rysunek 19. Przebieg generowany przez automatyczny klucz telegrafu Morse’a

Rysunek 20. Wariantowe charakterystyki wzmacniacza zależne od zastosowanych typów 
tranzystorów

{tranzystor}. Musimy jeszcze wstawić odpowiednio zredagowane 
polecenie wymiany tranzystorów:
.step param tranzystor list 3904 2 5472 5473

Wszystko jest gotowe, rozpoczynamy symulację. Zbadamy charakte-
rystykę częstotliwościową naszego wariantowego wzmacniacza. Jest ona 
pokazana wraz ze schematem na rysunku 20. Wszystko stało się jasne. 
Musimy tylko zdecydować, czy bardziej nam zależy na wzmocnieniu, 
czy na paśmie.

Czas leci...
Ten odcinek ukazuje się dokładnie po dwóch latach od zapowiedzi 
cyklu. To czas, po którym może już występować „zmęczenie mate-
riału”. Na temat symulatora LTspice można by napisać jeszcze wiele, 
ale podjąłem decyzję o zakończeniu kursu. Ostatni odcinek ukaże 
się za miesiąc. Nie wykluczam powrotu do pewnych tematów, jeśli 
uznam, że są warte opublikowania. Będą to jednak już tylko poje-
dyncze artykuły.

Jarosław Doliński, EP

2N3904, MAT02 (oznaczenie 
w  bibliotece MAT-2 –  jest 
to para tranzystorów w jed-
nej obudowie) oraz tranzy-
storów BC547B i  BC547C. 
Zaczynamy od przygotowa-
nia aliasów: 
.model 3904 ako:2N3904
.model 2 ako:MAT-02
.model 5472 ako:BC547B
.model 5473 ako:BC547C

Nadajemy parametryczny typ 
tranzystora na  schemacie, np.: 


	model

